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How	to	change	a	pdf	to	a	word	document	on	windows	10

1	Open	Office	Lens.	Tap	the	Office	Lens	app	icon,	which	resembles	a	red	and	white	app	with	a	camera	iris	and	the	letter	"L"	in	the	center	of	the	icon.	2	Allow	Office	Lens	access	to	your	phone.	If	this	is	your	first	time	opening	Office	Lens,	tap	Allow	or	OK	when	prompted	to	allow	Office	Lens	to	access	your	phone's	files.	3	Tap	DOCUMENT.	It's	a	tab	at
the	bottom	of	the	screen.	4	Point	your	phone's	camera	at	a	document.	Position	the	document	that	you	want	to	scan	inside	the	camera's	view.	Make	sure	you	document	is	well	lit	so	the	camera	can	pick	up	as	much	detail	as	possible.	5	Tap	the	"Capture"	button.	It's	a	red	circle	at	the	bottom	of	the	screen.	This	will	take	a	photo	of	the	document's	page.	6
Tap	.	It's	in	the	bottom-right	corner	of	the	screen.	You	can	scan	more	pages	by	tapping	the	camera	with	the	plus	icon	at	the	bottom	of	the	screen.	7	Tap	Word.	You'll	find	this	option	in	the	"SAVE	TO"	section	of	the	"Export	To"	page.	On	Android,	tap	the	box	next	to	Word	and	then	tap	SAVE	at	the	bottom	of	the	screen.	8	Sign	into	your	Microsoft	account.
If	you	haven't	already,	enter	your	Microsoft	account	email	address	and	password.	Once	signed	in,	your	Word	document	will	be	uploaded	to	your	OneDrive	account.	This	must	be	the	account	that	you	use	to	log	into	Microsoft	Word	as	well.	9	Open	Word	on	your	computer.	It's	the	blue	app	with	a	white	document	and	the	letter	"W"	in	the	icon.	10	Click
Open	Other	Documents.	It's	on	the	left	side	of	the	window	below	the	"Recent"	section.	On	Mac,	simply	click	the	folder	icon	that	says	Open	on	the	left-hand	side	of	the	window.	11	Click	OneDrive	-	Personal.	It's	at	the	top	of	the	window.	This	will	open	your	OneDrive	folder.	If	you	don't	see	the	OneDrive	option,	click	+	Add	a	Place,	then	click	OneDrive
and	sign	in	with	your	Microsoft	account.	12	Go	to	the	Office	Lens	folder.	Click	on	the	"Documents"	folder,	then	click	the	"Office	Lens"	folder.	This	is	on	the	right	pane	of	the	window.	13	Double-click	your	Word	document.	This	opens	the	Word	document	you	scanned	using	Office	Lens	in	Microsoft	Word.	Many	times	we	may	have	an	image	(JPG	format)
with	us,	and	we	wish	it	could	be	edited.	It	could	be	an	important	document	that	you	may	want	to	edit	and	share	it	with	someone.	It	could	be	for	work	purpose,	for	educational	purpose,	or	for	printing	purpose.	However,	when	you	try	editing	the	JPG	image	it	will	not	be	possible,	because	it	does	not	come	with	that	option.But,	why	would	you	create	the
same	document	all	over	again	for	some	minor	changes?	To	save	your	time,	you	can	use	MS	Word	to	convert	the	JPG	file	to	an	editable	format.	Yes,	that’s	possible.	So,	now,	you	don’t	have	to	look	for	free	software	to	convert	images	to	Word.	You	can	do	it	within	the	Word	document.	Let’s	see	how.	Solution:	Using	MS	Word	Step	1:	Copy	the	image	which
you	want	to	convert	to	paste	it	on	a	blank	Word	file.	For	instance,	we	have	saved	the	image	on	our	Desktop.	We	right-clicked	on	it	and	clicked	on	Copy.	Step	2:	Open	a	blank	MS	Word	document.	Then	on	the	blank	Word	document,	press	Ctrl	+	V	keys	together	on	the	keyboard	to	paste	the	image.	Now,	click	on	the	File	tab	on	the	upper	left.	Step	3:	In
the	next	window,	click	on	Save	As	from	the	menu	on	the	left.	Now,	on	the	right	side	of	the	pane,	click	on	Browse.	Step	4:	This	will	open	the	This	PC	window,	where	you	can	select	the	location	to	save	the	converted	document.	For	instance,	we	selected	Desktop	to	save	the	converted	document.	Now,	name	the	file	as	per	your	choice.	For	instance,	we
named	it	as	Convert	to	pdf.	Select	Save	as	type	field	as		PDF	and	click	on	the	Save	button.	You	can	name	it	anything.	Step	5:	Now,	in	the	same	word	document,	go	to	the	File	tab	again,	select	Open	and	then	click	on	Browser.	Step	6:	In	the	File	Explorer	window	that	opens,	click	on	the	location	shortcut	on	the	left	side,	where	you	have	saved	the	PDF
document.	On	the	right	side	of	the	pane,	select	the	PDF	document	and	click	on	the	Open	button.	Step	7:	A	prompt	will	appear	stating	that	your	PDF	will	now	be	converted	to	an	editable	Word	document.	Press	OK.	Step	8:	Now,	wait	for	sometime	till	it	converts	the	PDF	to	editable	Word	document.	You	can	easily	edit	the	document	now	and	also
compare	the	image	and	the	document	alongside.	That’s	all.	You	are	done	converting	the	image	to	the	editable	Word	document.	You	can	freely	edit	now.	I	find	passion	in	writing	Tech	articles	around	Windows	PC	and	softwares	How	to	convert	a	PDF	to	Word	online	How	to	convert	a	PDF	to	Word	online	Follow	these	easy	steps	to	turn	a	PDF	into	a
Microsoft	Word	document:	Click	the	Select	a	file	button	above,	or	drag	and	drop	a	PDF	into	the	drop	zone.	Select	the	PDF	you	want	to	convert	to	the	DOCX	file	format.	Watch	Acrobat	automatically	convert	the	file.	Sign	in	to	download	or	share	your	converted	document.	It	would	be	beneficial	to	rename	a	document	when	you	manage	a	large	amount	of
Word	documents,	and	especially	when	you	rename	logically	and	simply,	those	word	documents	are	good	to	identify,	edit	and	organize.	This	tutorial	will	introduce	ways	to	rename	documents	for	you.	Rename	Word	document	by	right	click	after	saving	Rename	Word	document	by	Save	As	Rename	Word	documents	by	Office	Tab	Rename	Word	document
by	right	click	after	saving	Read	more	Free	download	Go	to	the	folder	you	save	the	document	to	right	click	on	the	document	and	select	Rename	in	the	Menu	context.	See	screenshot:	Rename	Word	document	by	Save	As	Kutools	for	Word,	a	handy	add-in,	includes	groups	of	tools	to	ease	your	work	and	enhance	your	ability	of	processing	word	document.
Free	Trial	for	45	days!	Get	It	Now!	Step	1.	Click	in		Word	2007	or	in		Word	2010/2013,	and	select	Save	As.	Step	2.	Choose	the	folder	you	want	to	save	to	and	rename	it	on	the	File	name	text	box,	click	Save	button.	See	screenshot:	Note:	1.	Select	the	type	you	need	from	Save	as	type	drop-down	list.	2.	It	will	rebuild	a	new	document	after	renaming	the
document.	Rename	Word	documents	by	Office	Tab.	If	you	install	Office	Tab	in	your	computer,	it	will	be	easy	and	quick	to	rename	documents	by	right	click	on	the	document	tab.	See	screenshot:	Use	Tabbed	Document	Interface	in	Office	2003/2007/2010/2013/2016/2019:	Using	tabs	in	Word,	Excel,	PowerPoint,	Publisher,	Access,	Project	and	Visio;	Easy
to	switch	back	and	forth	between	files	in	Microsoft	Office	2003/2007/2010/2013/2016/2019;	Compatible	with	Windows	XP,	Windows	Vista,	Windows	7	/	8	/	10,	Windows	Server	2003	and	2008,	Citrix	System	and	Windows	Terminal	(Remote	Desktop)	Server;	Free	trial	without	feature	limitation	in	30	days!	READ	MORE				|		FREE	DOWNLOAD		|			BUY
NOW	There	are	times	when	you	need	to	create	a	form	where	others	can	fill	out.	It	is	important	to	mention	that	creating	just	a	form	can	be	easy,	but	the	main	challenge	comes	with	creating	a	fillable	Word	document.	Knowing	how	to	make	a	Word	document	fillable,	you	need	to	read	up	the	steps	required	before	you	start	the	process.	Fortunately,
everything	you	need	to	know	on	how	to	create	a	fillable	PDF	in	Word	is	right	here.	How	to	Make	a	Word	Document	Fillable	In	order	to	make	a	Word	document	fillable,	you	are	likely	going	to	start	with	a	template	and	then	add	content	control.	Content-control	encompasses	a	lot	of	areas	like	drop-down	lists,	text	boxes,	checkboxes,	and	even	databases.
The	following	is	a	summary	of	the	steps	involved.	Step	1:	Show	Developer	tab.	To	do	this,	click	on	"File"	tab	>	"Options"	>	"Customize	Ribbon".	Then	under	the	"Customize	Ribbon",	select	the	"Developer"	checkbox	and	click	"OK".	Step	2:	Open	a	Word	document	and	you	will	be	able	to	make	the	Word	document	fillable.	Go	to	the	"Developer"	tab	and
then	"Design	Mode",	and	you	can	then	insert	the	controls	that	you	want.	It	could	be	a	text	control	where	users	will	be	able	to	enter	texts,	insert	a	combo	or	drop-down	list,	a	date	picker,	or	a	checkbox.	Step	3:	Set	or	change	"Properties"	to	"Content	Control	Properties".	Here,	you	can	add	title,	tag,	or	change	the	color.	Step	4:	You	can	add	protection	to
the	form	by	using	the	"Restrict	Editing".	Open	form	then	click	"Home"	>	"Select"	>	"Select	All".	Then	click	on	"Developer	"">	"Restrict	Editing".	With	these	steps	above,	you	have	succeeded	in	making	a	fillable	word	document.	If	you	want	to	test	what	you	have	done	before	distributing	it.	You	can	open	the	form	and	have	it	filled	out	like	the	user	will	do
and	see	if	it	actually	works.	You	can	save	it	in	the	end.	How	to	Create	a	Form	in	PDF	Documents	PDFelement	boasts	of	topnotch	features	like	editing	as	easy	as	it	is	in	word,	converting	to	and	from	PDF	formats,	annotating	PDFs,	digital	signature	application,	redaction,	merge	and	split,	and	many	more.	It	is	a	complete	PDF	solution	that	provides	all	the
capabilities	that	you	need	for	your	PDF	handling.	Step	1.	Open	PDF	document	First,	open	the	form	document	in	PDFelement	but	you	have	to	use	the	“Open	File”	button	to	upload	it	to	the	program.	Step	2.	Create	a	Fillable	Form	Go	to	the	"Form"	tab,	there	are	several	tools	help	you	create	a	fillable	PDF	form	you	want,	such	as	"Add	text	field,"	"Add
check	box,"	"Add	radio	button,"	or	"Add	combo	box,"	etc.	Step	3.	Edit	the	created	fillable	PDF	File	After	adding	PDF	form	fields,	click	the	"Preview"	switch	icon	on	the	top	right	and	you	can	fill	in	the	fillable	form.	Step	4.	Save	the	PDF	file	Once	done,	click	the	"Save"	to	save	the	file	or	tap	on	"File"	>	"Share"	>	"Wondershare	Cloud"	to	share	this	file	to
Wondershare	Document	Cloud,	allowing	you	to	access	and	download	the	document	at	any	device.	Advantages	of	PDF	Format	We	have	seen	how	to	make	a	word	document	fillable	but	you	may	also	decide	to	make	your	PDF	document	fillable	instead	of	word.	For	this	reason,	it	is	important	to	know	how	it	can	be	done	in	PDF.	For	the	avoidance	of	doubt,
it	is	important	to	state	here	that	PDF	is	the	most	popular	file	format	for	anyone	sharing	documents	online.	It	is	used	by	businesses,	corporate	organizations,	government	officials,	and	even	individuals.	The	advantages	of	PDF	document	format	are	over	all	other	file	formats	cannot	be	overemphasized.	In	the	first	instance,	a	lot	of	people	look	to	use	PDF
for	the	very	fact	that	it	is	the	most	secure	file	format.	By	security,	we	mean	that	PDF	cannot	be	easily	compromised.	This	is	because	there	are	a	lot	of	options	that	tend	to	guarantee	the	security	of	PDF.	For	instance,	you	can	prevent	unauthorized	use	or	access	to	a	PDF	file.	You	can	do	this	by	putting	a	password	that	will	lock	it	out	from	being	accessed
unless	the	person	to	access	it	has	a	password	to	open	it.	PDFs	can	only	be	edited	through	the	use	of	PDF	editors.	PDFelement	is	one	of	such	editors	that	can	help	take	total	control	of	your	PDF.	PDFelement	with	respect	to	its	price	and	features	is	the	perfect	alternative	to	Adobe.	This	is	why	many	professionals,	businesses,	and	individuals	are	now
patronizing	PDFelement.	It	is	easy	to	use	software	with	a	user-friendly	interface	and	does	not	require	that	the	user	is	technically	inclined.	Free	Download	or	Buy	PDFelement	right	now!	Free	Download	or	Buy	PDFelement	right	now!	Buy	PDFelement	right	now!	Buy	PDFelement	right	now!	Usually,	Windows	10	sets	a	program	to	open	one	type	of	file.
However,	a	file	can	always	be	opened	by	more	than	one	program.	You	may	want	to	use	another	program	to	open	a	file.	Do	you	know	how	to	change	what	program	opens	a	file	on	Windows	10	(that	is	how	to	change	file	associations	on	Windows	10)?	This	post	from	MiniTool	Software	will	show	you	a	guide.	File	association	is	a	computing	term.	It	always
associates	a	file	with	an	application	capable	of	opening	that	file.	Usually,	a	file	association	associates	a	class	of	files,	which	are	usually	determined	by	their	filename	extension	like	.txt,	with	a	corresponding	application	like	a	text	editor.	That	is,	a	file	will	be	opened	using	the	default	or	your	specified	program	and	it	is	determined	by	the	file’s	extension.
For	example,	if	a	.jpg	file	is	set	to	be	opened	with	Paint,	all	.jpg	files	will	associate	with	Paint.	If	you	want	to	open	the	file	using	another	program,	you	need	to	change	Windows	10	file	associations	on	Windows	10.	Here	comes	the	main	point	of	this	post:	how	to	change	what	program	opens	a	file	Windows	10?	It	is	not	a	difficult	job.	We	will	tell	you	how
to	associate	files	on	Windows	10	in	the	following	contents.	Read	also:	How	to	Show	File	Extensions	in	Windows	10?	Change	One	File	Type	How	to	change	file	associations	on	Windows	10	for	only	one	file	type?	You	can	follow	this	simple	guide:	1.	Right-click	on	a	file	of	the	type	you	want	to	change	its	file	association	and	then	go	to	Open	with	>	Choose
another	app	>	More	apps.	Tip:	If	you	can’t	find	the	app	you	want	to	associate	files,	you	can	click	Look	for	another	app	on	this	PC	to	find	more	options.	2.	Select	the	app	you	want	to	associate	with	the	file	type.	3.	Click	OK	to	save	the	change.	Next	time,	when	you	open	that	type	of	file,	it	will	be	opened	with	the	newly	specified	app.	Change	All	or	Any
Types	If	you	want	to	change	all	or	any	types	of	file	associations	on	Windows	10,	you	need	to	make	some	changes	in	Settings	like	this:	1.	Click	Start.	2.	Go	to	Settings	>	Apps	>	Default	apps.	3.	Scroll	down	and	click	Choose	default	applications	by	file	type.	4.	Find	the	file	extension	that	you	want	to	change	its	default	application	and	then	click	Choose	a
default.	If	there	is	a	default	application,	you	can	just	click	the	app	to	continue.	5.	Select	the	application	you	want	to	use	from	the	pop-out	interface.	If	you	find	your	needed	application,	you	can	click	Look	for	an	app	in	the	Microsoft	Store	to	get	your	needed	one.	Next	time,	Windows	will	use	your	specified	applications	to	open	different	types	of	files.
How	to	Change	File	Associations	on	Windows	8.1/8/7?	Some	of	you	are	still	using	Windows	8.1/8/7,	the	way	to	change	file	associations	is	different:	Open	Control	Panel.	If	you	are	using	Windows	8/8.1,	you	can	press	Win+X	to	directly	open	it.	If	you	are	using	Windows	7,	you	can	access	it	through	the	Start	Go	to	Programs	>	Default	Programs	>
Associate	a	file	type	or	protocol	with	a	program.	After	entering	the	Set	Associations	tool,	you	can	scroll	down	and	select	the	file	extension	you	want	to	change	the	default	program	for.	Click	Change	program	that	is	on	the	top	right	side	of	the	table.	Select	the	program	you	want	to	use	to	open	that	type	of	file.	Here,	you	can	click	Other	Programs	to	see
more	options.	Click	OK	to	save	the	change.	Bottom	Line	How	to	change	what	program	opens	a	file	on	Windows	10?	After	reading	this	post,	you	can	get	what	you	want	to	know.	Should	you	have	any	related	issues,	you	can	let	us	know	in	the	comment.	Stella	Follow	us	Position:	Columnist	Stella	has	been	working	in	MiniTool	Software	as	an	English	Editor
for	more	than	4	years.	Her	articles	mainly	cover	the	fields	of	data	recovery	including	storage	media	data	recovery	and	phone	data	recovery,	YouTube	videos	download,	partition	management,	and	video	conversions.
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